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Chapter 1
Welcome

Welcome to the Web TimeSheet Integration Manager for QuickBooks (the
Integration Manager).

This chapter summarizes the functionality of the Integration Manager, and
describes some of its key concepts and limitations.

The Integration Manager lets you transfer data between Web TimeSheet and
QuickBooks. The following types of data can be transferred in both directions
between the two applications:

¢ User/Employee Information

¢ Vendor Information

¢ Client/Customer Information

* Project/Task (Job/ltem) Information

In addition, the following data can be transferred from Web TimeSheet to
QuickBooks, but cannot be transferred from QuickBooks to Web TimeSheet:

* Time Entries
* Expense Entries

The Integration Manager is installed as a menu item in the QuickBooks main menu.
When you run the Integration Manager from the QuickBooks menu, it connects to
Web TimeSheet and launches an interface screen that allows you to specify the
data that you want to transfer.



Integration Manager Concepts

Chapter 1

Before you attempt to transfer any data, you need to understand the methods used
by the Integration Manager to relate data in Web TimeSheet to data in QuickBooks,
and vice versa. The Integration Manager uses the following two methods of relating
the data:

* Field Mapping, which maps specified data fields in one application to specified
data fields in the other application.

¢ Structural Relationship, which relates the data structure used in one application
to an alternative data structure in the other application.

These concepts are explained in more detail later in this chapter.

QuickBooks Client Invoice Generation

The following diagram illustrates how client invoices are generated within
QuickBooks. This shows the relationship between jobs and items, and time and
expenses, and is useful to understand when mapping data between Web
TimeSheet and QuickBooks.

Vendor Bill

:— Client Invoice—:

Vendors ! Time |

| Expenses |

| |

| I

| |

Employees | Time |

| Expenses |

e |

r A v I
|

| Customers - Jobs - Items :

| has contains |

U —



Terminology

The following table relates the terminology used in Web TimeSheet to the
terminology used in QuickBooks.

Web TimeSheet QuickBooks
Users Employees
Client Customer
Project Job or Item
Task Sub Job or Item
Role Item
Time Time
Comments Notes
Expense Expense

Field Mapping

Field mapping specifies which data fields in Web TimeSheet are to be transferred
to specified data fields in QuickBooks, and vice versa. You can either define the
field mapping to be used for each data transfer, or you can accept the default,
before initiating the transfer. Choices of field mappings vary depending on the data
being transferred, and can be selected from the drop down menus on the
appropriate Integration Manager screen.

Additionally, the fields available for mapping are determined by the structural
relationship selected. The structural relationship is displayed on the field mapping
screen to ensure clarity when choosing field mappings.

Structural Relationship

The structural relationship determines the relationship between Web TimeSheet
Projects/Tasks and QuickBooks Jobs/ltems when transferring Projects/Task, Time
Entries, or Jobs/Items. It is important to select a structural relationship because of
the large number of options available within QuickBooks.

The structural relationship can be selected from the appropriate Integration
Manager screen.

Welcome



Chapter 1

The structural relationship options available between Web TimeSheet and
QuickBooks are:

* Web TimeSheet Project/Task => QuickBooks Job/Sub Job
* Web TimeSheet Project/Task => QuickBooks Job/Item

* Web TimeSheet Project/Task => QuickBooks Item/Sub Item
* Web TimeSheet Project/Role => QuickBooks Joh/Item

The structural relationship options available between QuickBooks and Web
TimeSheet are:

* QuickBooks Job/Sub Job => Web TimeSheet Project/Task
* QuickBooks Item/Sub Item => Web TimeSheet Project/Task

When transferring data from QuickBooks to Web TimeSheet, these are the only
two structural relationship options available. For more information on this topic, see
the section Mapping Jobs/Items.

Modifying and Deleting Information

When you make changes to employee, vendor, client or project names, you must
make identical changes in Web TimeSheet and QuickBooks prior to transferring
any data. If you do not, QuickBooks will create an additional item for employee,
vendor, client or project using the new name.

If you remove a timesheet row from a project in Web TimeSheet after that project
has been transferred to QuickBooks, and then attempt to transfer time for that
project with a date range that includes the deleted row, an error will be returned.
This is because Web TimeSheet does not keep track of rows that have been
removed, therefore there is no way to correlate these changes with QuickBooks.

When you are transferring data from Web TimeSheet to QuickBooks and a change
is made to the Web TimeSheet database after you have made a filter query in the
Integration Manager, the updated data in Web TimeSheet will not be transferred.
You must click the Apply Filters button to ensure that the updated data is
transferred.

Mapping Project Name

Web TimeSheet Project Name defaults to QuickBooks Job Name (which is
available only if it has not already been used for a different mapping relationship).

If class tracking is turned on in the Accounting preferences of QuickBooks, every
time entry must be able to map to a class in QuickBooks. If there is no match, or

there is more than one match, a message is displayed notifying your that there was
no matching class for [projectname], and that time entries for that project will not

be transferred. You can continue the data transfer with the knowledge that some

of the time entries could not be transferred.



Note: QuickBooks class is available for all structural relationships, and Project
Name can be mapped to more than one field (example, project => job, project =>
class).

For billable time, QuickBooks requires a customer/customer:job and service item
to be associated with the time. If the structural relationship is Job/Sub Job, and no
role mapping has been set up for Items, the Integration Manager creates a
"dummy" item for <None>.

For non-billable time, a customer/customer:job and/or service item may be used
(because it is not billable time, QuickBooks only requires one of these fields).

If the user has set up a mapping relationship of Project Name => Item
Name/Number, and has not mapped to jobs at all, the time for any project will be
applied directly to service items.

Mapping Project Code

Web TimeSheet Project Code defaults to QuickBooks Job Name (which is
available only if it has not already been used for a different mapping relationship).

If class tracking is turned on in the Accounting preferences of QuickBooks, every
time entry must be able to map to a class in QuickBooks. If there is no match, or
there is more than one match, a message is displayed notifying you that there was
no matching class for [projectcode], and that time entries for that project will not be
transferred. You can continue the data transfer with the knowledge that some of
the time entries could not be transferred.

Note: QuickBooks class is available for all structural relationships, and Project
Code can be mapped to more than one field (example, project => job,
project => class).

Mapping Single and Multiple Clients

Web TimeSheet 6.5 incorporates the concept of multiple clients on a single project
(refer to the Web TimeSheet User Guide for more information on multiple clients).

Client mapping is handled by the Integration Manager in the following ways:

1. If a project in Web TimeSheet has a single client, the Integration Manager
creates a single customer: job (if this is part of the selected structural
relationship) in QuickBooks.

2. Projects can only be transferred from QuickBooks to Web TimeSheet if the
client names match exactly, or are <None>, in Web TimeSheet.

3. If a project in Web TimeSheet has multiple clients for cost allocation purposes
(these projects are billed to the client based on a percentage of the total cost),
the project cannot be transferred to QuickBooks.
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This limitation is caused by the following:

* WebTimeSheet does not perform calculations until the reporting phase,
therefore there is no information on the amounts that any client should be
charged. As a result, time and expenses for this type of project cannot be
associated with a single client.

* QuickBooks does not allow multiple clients, therefore there is no easy way
to transfer project information and associated time and expenses for cost
allocated projects.

4. If a project in Web TimeSheet has multiple clients using the bucket allocation
method (see the Web TimeSheet User Guide for a definition of the bucket
method), the project can be transferred from Web TimeSheet to QuickBooks,
but cannot then be transferred back from QuickBooks to Web TimeSheet.

Mapping Jobs/Items

QuickBooks does not establish a simple hierarchical relationship between jobs and
items. The rules that govern the relationship between jobs and items in
QuickBooks differs from the rules that govern the relationship between projects
and tasks in Web TimeSheet. As a result, the Integration Manager does not allow
the establishment of a direct structural relationship between Web TimeSheet
Projects/Tasks and QuickBooks Jobs/Items.

Because of this, when you are transferring jobs and items, the information is
updated differently depending on the direction of data transfer.

When updating or modifying data, you must always click the Apply Filter button to
update any field that contains modified data. You can also click the Preview Data
button to preview and verify any items that you have selected to transfer.

Transferring Web TimeSheet Projects/Tasks to QuickBooks

When you are transferring projects and tasks from Web TimeSheet to QuickBooks,
the projects are mapped to jobs, and the tasks are mapped to service items.
QuickBooks service items allow hierarchies, therefore when transferring Web
TimeSheet task data to QuickBooks service items, the entire task hierarchy is
maintained.

Transferring QuickBooks Jobs/ltems to Web TimeSheet

When you are transferring jobs and items from QuickBooks to Web TimeSheet,
there is no hierarchical relationship between jobs and items in QuickBooks.
Consequently, there is no way to determine which items and jobs belong together,
and the Integration Manager has no way to create appropriate projects/tasks in
Web TimeSheet. Therefore, there is no option to map QuickBooks job/item to Web
TimeSheet project/task.



Note: Do not confuse QuickBooks customer related custom fields with job related
custom fields. QuickBooks does not allow custom fields at the job level (only at the
customer level); therefore, you cannot map Web TimeSheet Project/Task User
Defined Fields (UDFs) to customer related custom fields in QuickBooks. This
means that only item related custom fields will be available for mapping to Web
TimeSheet Project/Task UDFs.

Vendor Identifiers

You can enter a formula for the name that appears on vendor bills. See the section
Using the Login Name Formula in Chapter 3 for more information.

When transferring expenses, it is important to note that the Integration Manager
may find users who do not have vendor profiles in QuickBooks. This occurs
because an employee has submitted an expense, and all expenses must be
entered in vendor bills. However, because QuickBooks does not allow an
employee to also be a vendor (that is, an employee cannot be attached to a vendor
bill), additional text is often added to the employee's name to identify the employee
as a vendor (example, "John Smith - vendor"). The same formula can be used for
each case where an employee is also a vendor.

When transferring expense entries from Web TimeSheet to QuickBooks, the
Integration Manager provides the ability to set up the formula that will be used (e.g.,
"$FirstName $LastName - Vendor"). With this type of formula in place, the
Integration Manager can create vendor accounts for those users who have
submitted expenses and do not already have a vendor account.

Although only two formula fields are provided in the Integration Manager, there are
additional fields in QuickBooks for vendors. The Integration Manager automatically
maps Web TimeSheet information to the First Name, Last Name, and Contact (first
and last names) fields for each vendor. Note that the vendor names in QuickBooks
may have a different stucture than First Name, Last Name.

Mapping Expenses
When transferring expense entries, the Integration Manager searches for matching
vendors as follows:

1. Search for a vendor name that matches the Web TimeSheet user's name. If
there is no match, go to Step 2.

2. Search for a vendor name that matches the vendor name formula for that user
(example, JSmith - vendor). If there is no match, go to Step 3.

3. Create a new vendor using the vendor name formula set up on the Expense sub
tab for Field Mapping.
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Each expense entry must map to an expense account. The Integration Manager
searches main and sub accounts for a matching name (the source field for the
match depends on the selected mapping relationships). If there is no matching
account, or if there is more than one match, the expense entry is not transferred to
QuickBooks and an error is recorded in the log file.

Non-billable expenses are mapped to the Expense tab on the QuickBooks vendor
bill.

Billable expenses are mapped to the Items tab on the QuickBooks vendor bill,
because billable expenses are eventually added to a client invoice.

Note: Expense entries come from Web TimeSheet projects only. There are no
tasks associated with expenses in Web TimeSheet.

Modifying Transferred Expenses

The Integration Manager cannot directly modify expenses after they have been
transferred to QuickBooks. If you want to modify transferred expenses, you must
complete a new expense transfer process for the modified expenses. The
Integration Manager will then effectively delete and replace the expenses.

When transferring expenses from Web TimeSheet to QuickBooks, you effectively
select the projects in Web TimeSheet associated with the expenses. So, if you
have two projects with associated expenses, Project 1 and Project 2, you can
select the following project combinations when transferring expenses:

* (Expenses from) Project 1 => QuickBooks
* (Expenses from) Project 2 => QuickBooks
* (Expenses from) Project 1 and Project 2 => QuickBooks

Therefore, when transferring expense sheets which include the expenses from
several projects you must determine which projects you would like transferred to
QuickBooks prior to the transfer. In the above example, you must decide if you
want to transfer Project 1, Project 2, or all of the projects.

If you choose only to transfer the expenses from Project 1, and later wish to add
the expenses for Project 2, you must complete the expense transfer process again,
this time selecting both Project 1 and Project 2. The Integration Manager will
effectively delete and replace the expenses.

If you are likely to modify your Web TimeSheet expense sheets after transferring
them to QuickBooks, you may wish to consider selecting All Projects when
transferring expenses.

When updating or modifying data, you must always click the Apply Filter button to
update any field that contains modified data. You can also click the Preview Data
button to preview and verify any items that you have selected to transfer.



Time Entries (Role Name and Role Rate)

Web TimeSheet Role Name defaults to QuickBooks Item Name/Number (which is
available only if it has not already been used for a different mapping relationship).

If class tracking is turned on in the Accounting preferences of QuickBooks, every
time entry must be able to map to a class in QuickBooks. If there is no match, or
there is more than one match, a message is displayed notifying you that there was
no matching class for [rolename], and that time entries for that role will not be
transferred. You can continue the data transfer with the knowledge that some of
the time entries could not be transferred.

Note: QuickBooks class is available for all structural relationships, and Role Name
can be mapped to more than one field (example, role => item, role =>class).

When transferring role name (or role code) to items, the default global role rate is
transferred.

This applies to the following structural relationships:
* Project/Task => Job/Sub Job
* Project/Role => Job/Item

If you select the structural relationship Project/Task => Job/Sub Job and want to
transfer timesheet data that is billable, the role is required for item information if the
billable status is to remain intact. Therefore, when you transfer job/item

information, it is necessary to map roles to items using the global role information.

Role Rate
This only applies if the structural relationship is Project/Role => Job/Item.

In this case, the rate used is the rate specified for the role at the global level. This
is because, in Web TimeSheet, roles are created at the global level, but can be
modified at the project level. The rate used should always be the rate owned by the
role at the global level, because the Integration Manager does not allow multiple
copies of the same role in QuickBooks (duplicates would be required to have the
project specific rate).

Welcome
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Scenarios

For the structural relationship Project/Task => Job/Sub Job, the role-to-item
mapping scenarios are as follows:

Scenario 1

1.
2.

The user chooses to map role information to QuickBooks service items.

The user transfers project/task/role data to QuickBooks jobs/sub jobs/items,
where the roles are identified with the project name (Project - Role).

The user chooses to map role name to service item in QuickBooks time to
account for billable time entries.

The user transfers time entries to QuickBooks time. For billable time entries, the
Integration Manager checks the billing type of the entry in Web TimeSheet. If
the type is "Role Rate", the Integration Manager checks for both the Project -
Role format and the Role Name format (no project information attached to role
name) when transferring the time data. If no matching role information is found,
the Integration Manager changes time to non-billable and records the change in
the log file.

Scenario 2

The user chooses to not map role information to QuickBooks service items.
The user transfers project/task data to QuickBooks jobs/sub jobs.

The user chooses to map role name to service item in QuickBooks time to
account for billable time entries.

The user transfers time entries to QuickBooks time. For billable time entries, the
Integration Manager checks the billing type of the entry in Web TimeSheet. If
the type is "Role Rate", the Integration Manager checks for both the Project -
Role format and the Role Name format (no project information attached to role
name) when transferring the time data. If no matching role information is found,
the Integration Manager changes time to non-billable and records the change in
the log file.

Scenario 3

A w0

The user chooses to not map role information to QuickBooks service items.
The user transfers project/task data to QuickBooks jobs/sub jobs.
The user chooses to not map role name to service item in QuickBooks time.

The user transfers time entries to QuickBooks time. If there are billable time
entries, the Integration Manager changes time to non-billable in QuickBooks
and records the change in the log file.



Mapping Time Off Codes

Web TimeSheet time off codes should only be mapped to payroll items in
QuickBooks if you are only tracking time off.

If you need to track time off against tasks, it is recommended that you set up a User
Defined Field (UDF) in Web TimeSheet at either timesheet row or cell level that
applies to both tasks and time off. The UDF can then be mapped to payroll items
in QuickBooks. This will ensure that you always have the information you require
(payroll items are required in QuickBooks if a user is set up to use them; if this is
the case, you must always have a matching payroll item).

Welcome
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Chapter 2
Getting Started

This chapter explains how to install the Web TimeSheet Integration Manager for
QuickBooks

System Requirements

Before you install the Integration Manager, make sure that your system meets the
system requirements listed below.

Minimum hardware requirements:

¢ PC with P500 cpu or equivalent

¢ 512MB memory

¢ 50MB available disk space

Operating system requirements (one of the following):
¢ Windows 9x

* Windows NT/2000/2003

¢ Windows XP Professional

Browser requirements (one of the following):
¢ Internet Explorer 5.5 or higher

* Netscape Navigator 7.1 or higher

* Mozilla Firefox 1.0

Web TimeSheet 6.5 or higher

Either:

¢ Intuit QuickBooks (US) 2003, 2004 and 2005, or
¢ Intuit QuickBooks (Canadian) 2005

® o 0o 0 00
=
w
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Operational Limitations

The following operational limitations exist when running the Integration Manager
with the specified versions of QuickBooks:

Chapter 2

QuickBooks patch updates. It is recommended that you update your version
of QuickBooks to include all the patches up to March 2005.

QuickBooks 2003.

* The Customer field Notes is not available in QuickBooks 2003. If you attempt
to transfer data from Web TimeSheet to this field, a message will be logged
in the Integration Manager gbi log . txt.

* The Status/Active fields are not supported for Vendor, Customer, or
Employee in QuickBooks 2003. If you attempt to transfer this data, a
message will be logged in the Integration Manager gbilog. txt.

* You cannot modify data transferred between Web TimeSheet and the
custom fields for Employees, Vendors, Customers and Jobs/ltems in the
QuickBooks 2003 Premier (US) version.

QuickBooks 2004 Professional (US) version. There are some issues with
support for the currency symbols for Pound, Yen and Euro in the custom fields
of this version.

Integration Manager Installation.

* The Integration Manager supports only one version of QuickBooks installed
on your computer.

* The Integration Manager is installed as a menu entry in QuickBooks 2004
and 2005, and is installed as a standalone application for QuickBooks 2003.

* The Integration Manager must be un-installed if QuickBooks is being un-
installed.

Custom field length limitation. Client User Defined Fields (UDFs) in Web
TimeSheet allow data up to 50 characters, however custom fields in
QuickBooks only allow up to 30 characters. As a result, if you attempt to transfer
data which has a field length greater than 30 characters from a Web TimeSheet
UDF to a QuickBooks customer field, an error message will be displayed and
will be logged in gbi log. txt.

French (Canada) regional settings. French (Canada) regional settings are not
supported in the Integration Manager for QuickBooks version 2.1.



Installing the Integration Manager

If you have Web TimeSheet and QuickBooks installed on different servers, you
must install the Integration Manager on the same system as QuickBooks.

Before installing or uninstalling the Integration Manager, close all other Windows
applications, in particular make sure that Web TimeSheet and QuickBooks are not
running.

To install the Web TimeSheet Integration Manager for QuickBooks, download and
run the installation program supplied by Replicon.

1. The Welcome screen appears. Click Next.

;Fl'_e Web TimeSheet Integration Manager For QuickBo x|

Welcome to Wweb TimeSheet Integration b anager for
QuickBooks Setup program. This program will inzstall

=  ‘web TimeSheet Integration kanager for QuickBooks
Oh Your computer,

[t iz strongly recommended that you exit all Windows programs before
running thiz S etup program.

Click Cancel to quit Setup and close any programs pou have running.
Click Mest to cantinue with the Setup pragrar .

Wt RMING: This program iz protected by coppnght law and
international treaties.

[Jhautharized repraduction ar distribution af thiz program, or any partion
of it, may result in sexvere civil and criminal penalties, and will be
prozecuted bo the maximum extent pozsible under law.

Cancel |

Getting Started 15



2. Read the license agreement. If you agree to the terms, click Accept.

*_,".élr License Agreement ﬂ

SOFTWARE LICEMSE AGREEMENT ﬂ

Thiz computer program iz protected by copyright and other
intellectual property laws and international treaties. Unauthanzed
reproduction, ransmiszion, de-compiling, tranzlation, reverse
engineenng, creation of denvative works, copying GUI and/or
copyrightable concepts, or distibution of this computer program, or
any portion of it, iz exprezzly prohibited by law, and may result in
zevere oivil and criminal penalties. Vialators will be prozecuted ta the
maximum extent poszible. [nformation regarding unauthorized
copping of thiz computer program is gratefully received at [403)
262-6511,

PLEASE READ THIS AGREEMENT CAREFLILLY. BY USING ALL

OF &MY PORTION OF THE SOFT'WARE, OF BY PAYING FOR

THE SOFTWARE BY &MY MEANS OFFERED B REFLICON,

0L ACCEPT &LL THE TERMS AND CONDITIONS OF THIS
AGREEMEMT. O AGREE THAT THIS AGREEMEMT IS
EMFORCEABLE LIKE &MY wWRITTEM HEGOTIATED j

Setup will inztall wieb TimeSheet Integration kanager for QuickBooks
i1 the fallowing folder.

To inztall into a difterent folder, click Browse, and select another
falder.

You can choose nat to install 'Web TimeSheet Integration Manager for
GuickBooks by clicking Cancel to exit Setup.

A q Destination Faolder
’7 C:h AWTS Integration FManager for Quic..  Browse... |

< Back | Cancel |

Chapter 2



4. Choose the Program Manager group where you want the application icons to

be installed (or leave the default), and click Next.

*_,rél_e Select Program Manager Group

Enter the name of the Program tanager group to add *eb
TimeSheet Integration Manager for QuickBooks icons to:

“w'eb TimeSheet Integration Manager for QuickBooks

Accezsones
Adrministrative Tools
Adobe

AQL Instant Messenger
AvantEo

HTHL Help “Workshop
Microzoft Office

M ozilla Firefox

MSxML 4.0

Metscape 7.2

Mortan Anttirug Corporate E dition
Palm Desktop

Frintkd e Internet Printing
Cuadralay

< Back |

5. You are ready to install the software. Click Next.

CuickBooks.

re-enter the ingtallation information.

You are now ready to install *Web TimeSheet Integration M anager for

Press the Mest button ta begin the inzstallation, or the Back button to

< Back |

Cancel |

Getting Started
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6. Allow the installation program to install the software.

%@3

=101 x|

— Current File

Copying file:
C:h AbinhOBFCA_Olnstaller. exe

— Al Files

Time Remaining 0 minutes 4 seconds

< Back | i [= | Cancel I

7. When the software is installed, the Installation Complete screen appears. Click

Finish to complete the installation.

*_,% Web TimeSheet Integration Manager For QuickB

A% eb TimeSheet item has been added tao the
CluickBooks menu. Restart CuickBooks and
accept the certificate o implement this
change.

¢ Back | Finizh I

Cancel




8. The Integration Manager is now installed. Go to the next section, Adding a
License Key.

43 web Timesheet Integration Manager for QuickBook: x|

Installation Complete

A% eb TimeSheet item has been added to the QuickBooks
menu. Bestart QuickBooks and accept the certificate to
implerment thiz change.

< Back | LCancel |

Getting Started 19
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Adding a License Key

Chapter 2

The Web TimeSheet Integration Manager for QuickBooks requires a license key

before you can use it. The Integration Manager uses the same license key that the
previous Web TimeSheet Integration Manager for QuickBooks (XML) application

used. To activate your version of the Integration Manager, follow the appropriate

procedure below.

Adding a License Key for the First Time
To add a license key for the first time:

Launch Web TimeSheet.

Click the Admin button.

Click About Web TimeSheet in the side menu.
Click the License Key tab.

Click the Add button.

Enter the license key for the XML version of the Integration Manager, and click
Save.

© o wDdPRF

7. Turn off permissions for the XML version, as described below.

The Integration Manager is now active. Go to the section Logging in to the
Integration Manager.

Replacing the License Key for the Integration Manager

If you are replacing the previous XML version of the Integration Manager with the
newer version Integration Manager, the XML license key that you previously used
will work with the new version of the application. However, you should turn off
permissions for the XML version, as described below.

Turning Off Permissions for the XML version of Integration Manager
Turn off permissions for the XML version of Integration Manager, as follows:

Launch Web TimeSheet.

Click the Admin button.

Click Setup in the side menu.

Click Permissions.

Click Administrator in the Name column

Under the System tab, expand the Integration section by clicking the ‘+'.
Uncheck WTS Integration Manager for QuickBooks XML.

Click Save.

© N o g bk~ w DN PE



Logging in to the Integration Manager

When the software is successfully installed, a Web TimeSheet menu item is
installed in the QuickBooks main menu. When you have activated the Integration
Manager with a license key, you can start the application as follows:

1. Launch QuickBooks, and select File > Web TimeSheet Integration Manager
from the QuickBooks main menu.

Notes:

1. If you are using QuickBooks 2003, the Integration Manager is installed as a
stand alone application only and must be launched by clicking
Start>Programs>Web TimeSheet Integration Manager.

2. When the Integration Manager opens initially a Permissions Certificate appears.
If you cancel or close this certificate, the entry for Web TimeSheet Integration
Manager will not appear in the QuickBooks menu. If this happens, open
Edit>Preferences from the QuickBooks main menu, select the Company
Preferences tab and select Integrated Applications from the side menu. Make
sure that Web TimeSheet and the Web TimeSheet Integration Manager
applications are checked for Allow Access.

|Fi|e Edit View Lisks Company Customers Vendors Employees Banking Reports  ‘Window  Help

Mew Cormpany...

Open Companty...

Open Previous Companty b
EasyStep Inberview

Close Company

Switch bo Multi-user Mode

Back Up...

Restare..,

Irnpart 3
Export 4
Archive & Condense Data. ..

Ltilities 4
Timer 3
Accountant's Review »
Brimt ... CEH+HP
Save as FIDFE. .,

Print Forms 3
Printetr Setup...

Send Forms. ..

Shipping 3

Web TimeSheet: Inteqgration Manager

Update QuickBiooks. ..
Exit Alt+F4
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2. Enter your Web TimeSheet URL, Login Name and Password, and click
Connect. If you want the Integration Manager to automatically login to Web
TimeSheet, click the checkbox.

Web TimeSheet Security Login ' El

. Web
“Y TimeSheet

Wwieb TimeSheet URL |

Login Mame: I

Fazsword: I

[ Automatically login to 'Web TimeSheet nest time

Connect I Cancel

You can find the Web TimeSheet URL by opening the systeminfo.txt file which is
located in your Web TimeSheet installation directory. For example, c:\Program
Files\Web TimeSheet\systeminfo.txt. Atthe top of this file will be a line
that looks similar to this:

Web Server Address: http://<computername>:<portnumber>.

Enter this URL, http://<computernames: <portnumber>, in the Web
TimeSheet URL field.

3. The Web TimeSheet Integration Manager for QuickBooks application will open.

Go to Chapter 3, Transferring Data, for information on using the Integration
Manager.

Closing the Integration Manager

When you have finished transferring data you can close the Integration Manager
by clicking the Exit button.

Note: If you close the Integration Manager forcibly (that is, by using Windows Task
Manager) while data is transferring, you cannot re-start the application again using
the QuickBooks Integration Manager menu item. You must close QuickBooks and
re-start it before the Integration Manager menu item is activated again.



Chapter 3
Transferring Data

This chapter describes how to transfer data between Web TimeSheet and
QuickBooks.

Previewing Data

You can preview the data to be transferred, together with any related field
mappings, before initiating the transfer.

To preview the data to be transferred:
1. Log on to Web TimeSheet Integration Manager for QuickBooks.

The integration manager screen is displayed.

& Web TimeSheet Integration Manager for QuickBooks 7lx|

%

General | Fiskd Mapping | Configuaation |

Select Direction of Data Transfer oa
— — Settings
{ & fimesheet 5 C & VTimesheet ‘
Save
Select Datato Transfer SeiEe
¥ Employees ™ Vendors I™ Customers Riefresh
Filers
™ Jobs/items [~ Time Entries I Expenss Entries

Reset

Employess | Vendors| Customers| Jabs/ltems| Tims Enfres| Expenss Enties

e [ e

Exit
[~Web TimeSheet Data Filters
Date Filter Hel
elp
* Al

© Date Range From 10/05/2005  ~] To 10/06/2008 ¥
Login Status: [Enatled ~|  Employes Type: |<Al> ~| Department | <al> -

Aol Fiters |

From ‘Web TimeSheet Usars: To QuickBooks Emplopees:

L«

ﬂ Trarster Data

hitp: /A replicon.com

Warsion2.1.0.0
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2. Click the appropriate Select Direction of Data Transfer option.
3. Select the data to be transferred and the field mappings.

To learn more about transferring data, refer to the sections Transferring Data
from Web TimeSheet to QuickBooks and Transferring Data from QuickBooks to
Web TimeSheet.

4. Click the Preview Data button.
The Preview Data dialog box is displayed.

5. Click the appropriate tab to preview the data to be transferred for the selected
data type.

The data to be transferred is displayed in the Data to be transferred section,
and the mapping relationship for the data to be transferred is displayed in the
Mapping Information section.

6. Click the Close button to exit and return to the Interface screen.

Transferring Data from Web TimeSheet to QuickBooks

Chapter 3

You can transfer the following data from Web TimeSheet to QuickBooks:
* Employee data

* Vendor data

¢ Customer data

¢ Job/ltem data

¢ Time entries

* Expense entries

Note: When you are transferring data from Web TimeSheet to QuickBooks and a
change is made to the Web TimeSheet database after you have made a filter query
in the Integration Manager, the updated data in Web TimeSheet will not be
transferred. You must click the Apply Filters button to ensure that the updated
data is transferred.

Transferring Employee Data

You can transfer employee data from Web TimeSheet to QuickBooks. The
employee data to be transferred can be filtered on the basis of date range, login
status, employee type, and department.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in QuickBooks, as described in the section Mapping Employee Data. If the
fields are not mapped before transferring the data, only the First Name and Last
Name fields are transferred.




Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, QuickBooks will create an additional item for

employee, vendor, client or project using the new name.

To transfer employee data from Web TimeSheet to QuickBooks:

1. Log in to the Integration Manager.
The Integration Manager screen appears.

. Web Timesheet Integration Manager for QuickBooks

General I Field Mappingl Cnnf\gulationl

r— Select Direction of D ata Transfer

(O PRININE=Y QuickBooks | . & V' Himesheet

r—Select Data to Transfer

¥ Employess I~ Wendors [~ Customers

[ Jobsdtems I Time Entries [ Espense Entries

Employees | Vendorsl Custnmers' ansiltemsl Tirne Entriesl Expense Entriesl

—wieb TimeSheet Data Filters
Date Filter
Al
" Date Rangs Fram: I1U.i'05f’2005 'l To: IWD;"DEJZUUS 'I
Login Status: IEnabIad 'I Employee Type: |<AII> 'l Departrent |<A||> 'I
Apply Filters
From ‘weh TimeSheet Users: To QuickBooks Employees:
% |
[
ﬂ HEPLE[:I]H E Freview Data I Tiansfer Data

hittpe e replicon, com

gl

Load
Settings

Save
Settings

Refresh
Filters:
Reset

Exit

Help

e [ e

Wersion 2.1.0.0

2. Click the General tab.

3. In the Select Direction of Data Transfer section, select the
Web TimeSheet > QuickBooks option.

4. In the Select Data to Transfer section, select the Employees check box.

Transferring Data
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The Employees sub tab is enabled, displaying the following fields.

Field Description

Date Filter Select a date range from All or From: To:

The dates can also be entered in the
mm/dd/yyyy format.

The default is the current system date.

Login Status Select the login status from the drop-down
list.

Indicates the filter criteria based on the
employee login status.

The available options are:
® Both
* Enabled
® Disabled

The default is Enabled.

Employee Type Select the type of employee from the
drop-down list.

Indicates the filter criteria based on the
type of employee.

The default is All.

Department Select the department from the drop-
down list.

Indicates the filter criteria based on the
employee department.

The default is All.

From Web TimeSheet Select the Web TimeSheet items that you
want to transfer to QuickBooks.

To QuickBooks Displays the items that will be transferred.

5. Select the required filter criteria.
6. Click the Apply Filters button.

The available Web TimeSheet users are displayed in the From Web
TimeSheet Users box.

7. Select each user you want to transfer from the From Web TimeSheet Users box
and click the >> button.

The selected user is moved to the To QuickBooks Employees box.
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If you want to remove a user from the To QuickBooks Employees box, select
the user and click the << button.

8. If you want to map fields between Web TimeSheet and QuickBooks, click the
Field Mapping tab at the top of the screen

9. When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

10.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.

Note: After data has been transferred, the fields HireDate, ReleaseDate, Social
Security Number (SSN), and Social Insurance Number (SIN) can be added to
QuickBooks, but cannot be edited.

11.When you are done, click the OK button.

Mapping Employee Data

To map employee data prior to data transfer:
1. Log on to the Integration Manager.

2. Click the General tab.

3. Inthe Select Direction of Data Transfer section, click the
Web TimeSheet > QuickBooks option.

4. In the Select Data to Transfer section, select the Employees check box.

5. Under the Employees sub tab, select your required filter criteria and click the
Apply Filters button.

6. Click the Field Mapping tab.

The Employees sub tab containing the following fields is displayed:

Field Description

From Web TimeSheet Select the Web TimeSheet fields from the
drop-down list that you want to map to
QuickBooks fields.

Transferring Data
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Field Description

To QuickBooks Select the QuickBooks fields from the
drop-down list that you want the selected
Web TimeSheet fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

7. Select the fields you want to map from From Web TimeSheet and To

QuickBooks drop-down lists, and click the Add button.

8. The mapping relationship is displayed in the Selected Mapping Relationships
box.

9. To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

10.1f you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

11.When you are done mapping fields, click the General tab to return to
transferring data.



Employee Field Map between Web TimeSheet to QuickBooks

From Web TimeSheet To QuickBooks Comments
First Name First Name
Last Name Last Name
Employee ID Acct No (Emp ID) Defaults to Acct No (Emp ID)
SSN/SIN
Custom Field
Internal Email Address Email Defaults to Email
Custom Field
External Email Address Email Defaults to the first custom field
Custom Field Note: The External Email address
is only available as an option if
there is a license for the Web
TimeSheet Offline Timesheet
module.
Supervisor Custom Field Defaults to the first custom field
Department Custom Field Defaults to the first custom field
Hourly Cost Hourly Rate Defaults to Hourly Rate
Custom Field Note: There must be an Hourly
Cost item available in the Payroll
Item List in QuickBooks before
you can transfer an employee
Hourly Cost field from Web
TimeSheet.
_ Note: The Integration Manager
Start Date Hire Date cannot modify transferred Hire or
Release Dates in QuickBooks.
You should make sure you
End Date Release Date transfer this information on the
initial transfer.
Employee Type Custom Field Defaults to the first custom field
User UDF 1-5 Custom Field Defaults to the first custom field

Login Status (Enabled/Disabled)

Status (Active/lnactive)

This field is not available in
QuickBooks 2003 versions.

Transferring Data
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Transferring Vendor Data

You can transfer vendor data from Web TimeSheet to QuickBooks. The vendor
data to be transferred can be filtered on the basis of login status and employee

type.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in QuickBooks, as described in the section Mapping Vendor Data. If the fields
are not mapped before transferring the data, only the First Name and Last Name
fields are transferred.

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, QuickBooks will create an additional item for
employee, vendor, client or project using the new name.

To transfer employee data from Web TimeSheet to QuickBooks:
1. Log in to the Integration Manager.
The Integration Manager screen appears.

& Web TimeSheet Integration Manager for QuickBooks

General | Field Mapping | Eonhgurallonl

1 Select Direction of D ata Transfer Load

L

= = Seltings
1o —)\“{ﬁmesheet = L I=9_‘w\wﬁ'kimesheet
Save
—Select Data to Transter Sl
™ Emplopees ¥ Wendors ™ Customers Refresh
Filters
™ Jobsdltems ™ Time Entries [~ Expense Entries

Reset

f

Employees Vandorsl Euslnmafsl Juhs.r‘llemsl Time: Enlnesl Expensze Enlriasl
Exit

[ web TimeShest Data Filters
Help
Login Status:  |[SEEE) - Employee Type: |<A\I> 'I
Apply Filkers
From ‘Web TimeSheet Users: To BuickB ooks Vendors:
>> |
<4 |

ﬂ HEPL":I]" ; Preview Data Transfer Data
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. Click the General tab.

. In the Select Direction of Data Transfer section, select the
Web TimeSheet > QuickBooks option.

. In the Select Data to Transfer section, select the Vendors check box.
The Vendors sub tab is enabled, displaying the following fields.

Field Description
Login Status Select the login status from the drop-down
list.

Indicates the filter criteria based on the
employee login status.

The available options are:
® Both
* Enabled
® Disabled

The default is Enabled.

Employee Type Select the type of employee from the
drop-down list.

Indicates the filter criteria based on the
type of employee.

The default is All.

From Web TimeSheet Select the Web TimeSheet items that you
want to transfer to QuickBooks.

To QuickBooks Displays the items that will be transferred.

. Select the required filter criteria.
. Click the Apply Filters button.

The available Web TimeSheet users are displayed in the From Web
TimeSheet Users box.

. Select each user you want to transfer from the From Web TimeSheet Users
box, and click the >> button.

The selected user is moved to the To QuickBooks Vendors box.

To remove a user from the To QuickBooks Vendors box, select the user and
click the << button.

. If you want to map fields between Web TimeSheet and QuickBooks, click the
Field Mapping tab at the top of the screen

Transferring Data
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9. When you have prepared the data for transfer, including any required field

mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

10.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
11.When you are done, click the OK button.

Mapping Vendor Data

To map vendor data prior to data transfer:

1
2.
3.

Log on to the Integration Manager.
Click the General tab.

In the Select Direction of Data Transfer section, click the
Web TimeSheet > QuickBooks option.

In the Select Data to Transfer section, select the Vendors check box.

5. Under the Vendors sub tab, select your required filter criteria and click the

Apply Filters button.
Click the Field Mapping tab.
The Vendors mapping sub tab containing the following fields is displayed:

Field Description

Select the Web TimeSheet fields from the
drop-down list that you want to map to
QuickBooks fields.

From Web TimeSheet

To QuickBooks Select the QuickBooks fields from the
drop-down list that you want the selected
Web TimeSheet fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

Select the fields you want to map from From Web TimeSheet and To
QuickBooks drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.



To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

8. If you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

9. When you are done mapping fields, click the General tab to return to
transferring data.

Vendors Field Map between Web TimeSheet to QuickBooks

From Web TimeSheet To QuickBooks Comments

First Name First Name

Last Name Last Name

Internal Email Address Email Defaults to the first custom field
Custom Field

External Email Address Email Defaults to the first custom fields
Custom Field Note: The External Email address

is only available as an option if
there is a license for the Web
TimeSheet Offline Timesheet

module.
User UDF 1-5 Custom Field Defaults to the first custom field
Login Status (Enabled/Disabled)  Status (Active/Inactive) This field is not available in
QuickBooks 2003 versions.
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Transferring Customer Data

You can transfer client/customer data from Web TimeSheet to QuickBooks. The
client/customer data to be transferred can be filtered on the basis of status.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in QuickBooks, as described in the section Mapping Customer Data. If the
fields are not mapped before transferring the data, only the Client Name is

transferred.

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to

transferring any data. If you do not, QuickBooks will create an additional item for
employee, vendor, client or project using the new name.

1. Log in to the Integration Manager.

The Integration Manager screen appears.

& Web TimeSheet Integration Manager for QuickBooks

General | Field Mapping | Configuralion'

—Select Direction of Data Transfer

o _)\“ﬁ‘?meSheet = L I=>_’\‘.\§$§mesrleei
—Select Data to Transter
I Employees [~ wendors ¥ Customers
™ Jobsdtems ™ Time Entiies " Espense Entiies

Employeasl Wendars Customarsl Jobs!ltems' Time Enlnes' Expense Entnesl

21|

Load
Settings

Save
Settings

ki

Refresh
Filters

4

Reset

Exit

—eb TimeShest Data Filters

Status: Enabled <

Apply Filters
Fram ‘Web TimeShest Clients: To QuickBooks Custorers:
5 |
<4 |

RN

hittpe v replicon. com

Presview Data I Trangfer Data

d

Help
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2. Click the General tab.



. In the Select Direction of Data Transfer section, click the
Web TimeSheet > QuickBooks option.

. In the Select Data to Transfer section, select the Customers check box.

The Customers sub tab is enabled displaying the following fields.

Field Description
Status Select the customer status from the drop-
down list.

The available options are:
® Both
* Enabled
® Disabled

The default is Enabled.

From Web TimeSheet Select the Web TimeSheet items that you
want to transfer to QuickBooks.

To QuickBooks Displays the items that will be transferred.

. Select the required filter criteria.
. Click the Apply Filters button.

The available Web TimeSheet clients are displayed in the From Web
TimeSheet Clients box.

. Select each client you want to transfer from the From Web TimeSheet Clients
box and click the >> button.

The selected client is moved to the To QuickBooks Customers box.

To remove a user from the To QuickBooks Customers box, select the user
and click the << button.

. If you want to map fields between Web TimeSheet and QuickBooks, click the
Field Mapping tab at the top of the screen

. When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

10.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed with a progress bar indicating
the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
11.When you are done, click the OK button.

Transferring Data
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Mapping Customer Data

To map customer data prior to data transfer:

1.
2.
3.

Log on to the Integration Manager.
Click the General tab.

In the Select Direction of Data Transfer section, click the Web TimeSheet >
QuickBooks option.

In the Select Data to Transfer section, select the Customers check box.

5. Under the Customers sub tab, select your required filter criteria and click the

Apply Filters button.
Click the Field Mapping tab.
The Customer mapping sub tab containing the following fields is displayed:

Field Description

Select the Web TimeSheet fields from the
drop-down list that you want to map to
QuickBooks fields.

From Web TimeSheet

To QuickBooks Select the QuickBooks fields from the
drop-down list that you want the selected
Web TimeSheet fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

Select the fields you want to map from From Web TimeSheet and To
QuickBooks drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

. If you want to preview the field mappings, click the Preview Data button at the

bottom of the screen.

. When you are done mapping fields, click the General tab to return to

transferring data.



Customer Field Map between Web TimeSheet and QuickBooks

From Web TimeSheet

To QuickBooks

Comments

Client Name Customer Name Defaults to Customer Name
Client Code Custom Field Defaults to first custom field
Comments Notes This field is not available in
QuickBooks 2003 versions.
Default Billing Rate Currency Custom Field Defaults to first custom field
Default Billing Rate Custom Field Defaults to first custom field
Default Billing Rate Description ~ Custom Field Defaults to first custom field
Client UDF 1 - 12 Custom Field Defaults to first custom field
Client Rep Name Contact Defaults to Contact
Alt. Contact Note: If there are more than 2
Client Rep Names in Web
TimeSheet, the additional names
will not be transferred to
QuickBooks.
Internal Email Address Email If there are multiple Client Rep

Names in Web TimeSheet, then
the email address used is the one
associated with the Client Rep
Name mapped to the Contact field
(not Alt.Contact).

Client Status (Enabled/Disabled)

Customer Status
(Active/Inactive)

This field is not available in
QuickBooks 2003 versions.

User UDF 1-5

Defaults to first custom field

Defaults to first custom field

Transferring Data
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Transferring Job/Item Data
You can transfer details of jobs/items from Web TimeSheet to QuickBooks.

Before you transfer job/item data, you must define the structural relationship
between the Web TimeSheet data and the QuickBooks data. The structural
relationships you can choose from are as follows:

* Web TimeSheet Project/Task details can be transferred to QuickBooks Job/Sub
Job

* Web TimeSheet Project/Task details can be transferred to QuickBooks
Job/Item

* Web TimeSheet Project/Task details can be transferred to QuickBooks
Item/Sub Item

* Web TimeSheet Project/Role details can be transferred to QuickBooks Job/Item

The Job/Item data can be filtered on the basis of task status, billing status, client,
and project. The projects displayed in the drop-down list are dependent on the
client selected.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in QuickBooks, as described in the section Mapping Job/Item Data. If you
choose not to map any other fields, then only the following will be mapped by
default:

From Web TimeSheet To QuickBooks
Client Customer Name
Project Name Job Name

Task Name Sub Job Name

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, QuickBooks will create an additional item for
employee, vendor, client or project using the new name.



To transfer job/item data from Web TimeSheet to QuickBooks:
1. Log in to the Integration Manager.

The Integration Manager screen appears.

. Web TimeSheet Integration Manager for QuickBooks llil

General I Field Mappingl Configurationl

r—Select Direction of Data Transfer Load
n m Settings
o mv%meSheet =8 i '=9'7\wﬁme5heet
Save
r—Select Data bo Transfer Seltings
I Employees ™ Wendors ™ Customers HFglfresh
ilters

v Jobs/ltems " Time Entrizs I” Expense Entries

Fesst

Employeesl Vendorsl Customers Jnhsfltamsl Time: Entnes' Expense Entriesl
E it

—Structural Relationship

[w/eb TimeShest Project/Task - QuickBooks Job/Item =l

Help

o[ e el

—web TimeSheet D ata Filters

Task Status: IEoth 'I Biling Status: Bath 'I
Clignt: |<AI\> 'I Project <Al 'I
Apply Filters

From w'eb TimeSheet Projects/T asks To QuickBooks Jobs/ltems:
[ Administration - Administration
- Our Intranet Our Intranethlnternal

Our IntranetInternal\activities
Our Intranet\nternal\Caorp Updates

[ Activities Our IntranetilnternalyStaff List

>3
[ Corp Updates
<<

L. [ Staff List
. Er[CJExemal _I

=[] Public web
i [ Design
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2. Click the General tab.

3. Inthe Select Direction of Data Transfer section, click the Web TimeSheet >
QuickBooks option.

Transferring Data
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4. In the Select Data to Transfer section, select the Jobs/ltems checkbox.

The Jobs/Items sub tab is enabled displaying the following fields.

Field

Description

Structural Relationship

Select the required structural relationship
from the drop down menu.

Task Status

Select the task status from the drop-down
list.

The available options are:
® Both
® Closed
®* Open

The default value is Both.

Billing Status

Select the billing status from the drop-
down list.

The available options are:
® Both
¢ Billable
¢ Non-Billable

The default value is Both.

Client

Select the clients for whom you want data
transferred. The default is All.

Project

Select the projects for whom you want
data transferred. The default is All.

From Web TimeSheet

Select the Web TimeSheet items that you
want to transfer to QuickBooks.

To QuickBooks

Displays the items that will be transferred.

5. If you want to modify the structural relationship, select the required structural

relationship from the drop-down list.
6. Select the required filter criteria.
7. Click the Apply Filters button.

The available Web TimeSheet projects/tasks are displayed in a tree format in
the From Web TimeSheet Projects/Tasks box.

8. Click the + sign against the project/task name to view the tasks/sub tasks.



9. Select the checkbox against the project/task/sub task name and click the >>
button.

The selected project/task/sub task is displayed in the To QuickBooks
Jobs/ltems box.

To remove a job/item from the To QuickBooks Jobs/Sub Jobs box, select the
job/item and click the << button.

10.f you want to map fields between Web TimeSheet and QuickBooks, click the
Field Mapping tab at the top of the screen

11.When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

12.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.

13.When you are done, click the OK button to exit.
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Mapping Job/Item Data

To map job/item data prior to data transfer:

1.
2.
3.

Log on to the Integration Manager.
Click the General tab.

In the Select Direction of Data Transfer section, click the
Web TimeSheet > QuickBooks option.

In the Select Data to Transfer section, select the Jobs/ltems check box.

5. Under the Job/Items sub tab, select your required filter criteria and click the

Apply Filters button.
Click the Field Mapping tab.
The Job/Item mapping sub tab containing the following is displayed:

Field Description

Displays the structural relationship you
have selected.

Structural Relationship

Select the Web TimeSheet fields from the
drop-down list that you want to map to
QuickBooks fields.

From Web TimeSheet

To QuickBooks Select the QuickBooks fields from the
drop-down list that you want the selected
Web TimeSheet fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

7. Select the fields you want to map from From Web TimeSheet and To

QuickBooks drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

If you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

When you are done mapping fields, click the General tab to return to
transferring data.



Job/Iltem Field Map between Web TimeSheet and QuickBooks

From Web TimeSheet

To QuickBooks

Comments

Project Name

Job Name
Item Name/Number

Defaults to Job Name, which is
available only if it has not already
been used for another mapping
relationship. If Job Name is not
available, the default is the next
item on the list.

Project Code

Job Name

Item Name/Number
Service ltem/Number
Custom Field

Defaults to Job Name, which is
available only if it has not already
been used for another mapping
relationship. If Job Name is not
available, the default is the next
item on the list.

If the Structural Relationship
indicates a Project/Task to
Item/Sub Item mapping, then
Project Code is available for use
as the Service Iltem Account. This
is only available if the Structural
Relationship is Item/Sub Item,
and if the Service Item Account
has not been mapped elsewhere.

Project Description

Job Description
Item Description
Service Item Account

If the Structural Relationship
indicates a Project/Task to
ltem/Sub Item mapping, then
Project Description is available for
use as the Service Item Account.
This is only available if the
Structural Relationship is
Item/Sub Item, and the Service
Item Account has not been
mapped elsewhere.

Client Customer Name

Estimated Hours Custom Field Defaults to first custom field
Estimated Cost Custom Field Defaults to first custom field
Estimated Expenses Custom Field Defaults to first custom field
Time Entry Start Date Start Date

Time Entry End Date End Date Defaults to End date

Projected End
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From Web TimeSheet

To QuickBooks

Comments

Project Status (Open/Closed)

Job Status (Active/lnactive)
Item Status (Active/Inactive)

Project Name/Task Name

Item Name/Number

This maps both projects and tasks
(entire structure) to Items/Sub
ltems.

Project Code/Task Code Item Name/Number This maps both projects and tasks
(entire structure) to Items/Sub
Items.
Task Name Iltem Name/Number Defaults to Item Name/Number.
Sub Job Name
Task Code Iltem Name/Number Defaults to Item Name/Number,

Sub Job Name
Service ltem Account
Custom Field

which is only available if it has not
been used for a different mapping
relationship. If Item
Name/Number is not available,
defaults to the next item on the
list.

If the Structural Relationship
indicates a Project/Task to
Item/Sub Item or Job/Item
mapping, then Task Code is
available for use as the Service
Item Account. This is only
available if the Structural
Relationship is Item/Sub Item or
Job Item, and if the Service ltem
Account has not been mapped
elsewhere.

Task Description

Item Description
Sub Job Description

If the Structural Relationship
indicates a Project/Task to
[tem/Sub Item or Job/Item
mapping, then Task Description is
available for use as the Service
Item Account. This is only
available if the Structural
Relationship is Item/Sub Item or
Job Item, and if the Service Item
Account has not been mapped
elsewhere.

Task Status (Open/Closed)

Item Status (Active/Inactive)

Task Estimated Hours

Custom Field

Defaults to first custom field
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From Web TimeSheet

To QuickBooks

Comments

Task Estimated Cost

Custom Field

Defaults to first custom field

Role Name

Iltem Name/Number

Defaults to Item Name/Number,
which is only available if it has not
already been used for another
mapping relationship. If
Item/Name Number is not
available, default to blank.
This is available for the following
Structural Relationships:

* Project/Task>Job/Sub

Job

* Project/Role>Job/Item

Role Code

Item Name/Number

Defaults to Item Name/Number,
which is only available if it has not
already been used for another
mapping relationship. If
Item/Name Number is not
available, default to blank.
This is available for the following
Structural Relationships:

* Project/Task>Job/Sub

Job

® Project/Role>Job/Item

Role Description

Item Description
Service Item Account

Defaults to Item Description.

If the Structural Relationship
indicates a Project/Role to
Job/ltem mapping, then Role
Description is available for use as
the Service Item Account. This is
only available if the Structural
Relationship is Project/Role to
Job/ Item.

Role Rate

Iltem Rate

This is only available if the
Structural Relationship is
Project/Role to Job/Item. In this
case, the rate taken will be that
specified for the role at the global
level.

Role Status (Enabled/Disabled)

Item Status (Active/Inactive)

Project/Task UDF 1-10

Custom Field

Defaults to first custom field.
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Transferring Time Entries
You can transfer the details of time entries from Web TimeSheet to QuickBooks.

Before you transfer job/item data, you must define the structural relationship
between the Web TimeSheet data and the QuickBooks data. The structural
relationships you can choose from are as follows:

* Web TimeSheet Project/Task details can be transferred to QuickBooks Job/Sub
Job

* Web TimeSheet Project/Task details can be transferred to QuickBooks
Job/Item

* Web TimeSheet Project/Task details can be transferred to QuickBooks
Item/Sub Item

* Web TimeSheet Project/Role details can be transferred to QuickBooks Job/Item

The time entry data can be filtered on the basis of timesheet period, date range,
approval status, client and project.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in QuickBooks, as described in the section Mapping Time Entries Data. If you
choose not to map any other fields, then only the following will be mapped by
default:

From Web TimeSheet To QuickBooks
Project Name Job Name
Task Name Sub Job Name




To transfer time entries from Web TimeSheet to QuickBooks:
1. Log in to the Integration Manager.

The Integration Manager screen appears.

& Web TimeSheet Integration Manager for QuickBooks 2=

General I Field Mapplngl Eonhgurat\onl

[ Select Direction of D ata Transfer Load
- - Settings
& "fimesheet & L & V' TfimeSheet
Save
—Select Data to Transfer Seling
™ Employess I~ Wendors ™ Customers HFglfresh
ikers

™ Jobsdtems ¥ Time Entries I Espenss Ertries

Reset

Employeesl Vendorsl Customelsl Jobzdltems  Time Entnesl Expense Entliesl

e [r el

Exxit
i Structural Relationship
I\N’eb TimeSheet Project/Task --» QuickBooks Job/ltem ﬂ Help
— Tirme Frame Approval Status
* Timeshest Period: I2J‘27f’2005-3.-’5.¢‘2005 'l Al
" Start D ate: |17/UEJ2EIEI5 j End Date: IT?/UEJEUUE j = ppproved Only

Jobdtem Time Entries I Time O Entries |
—Wweb TimeShest Data Filters

Client: |<A||> 'I Project: <l < Apply Filters |

Time From ‘Web TimeShest Projects/Tasks: Ta QuickBoaks Time:
>3 |
< |

ﬂ Presiew Data Transfer Data

hittpe v replicon, com “ersion 2.1.0.0

2. Click the General tab.

3. Inthe Select Direction of Data Transfer section, click the Web TimeSheet >
QuickBooks option.

4. In the Select Data to Transfer section, select the Time Entries check box.

The Time Entries sub tab is enabled displaying the following fields.

Field Description

Structural Relationship Select the required structural relationship
from the drop down menu.
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Field Description

Timesheet Period, or Select the timesheet period or the dates
Start Date and End Date covering the period for which you want to
transfer time entries.

Approval Status Select the approval status of the time
entries you want to transfer.

Client Select the clients for whom you want data
transferred. The default is All.

Project Select the projects for whom you want
data transferred. The default is All.

From Web TimeSheet Select the Web TimeSheet items that you
want to transfer to QuickBooks.

To QuickBooks Displays the items that will be transferred.

. If you want to modify the structural relationship, select the required structural

relationship from the drop-down list.

. Select the time frame that covers the time entries you want to transfer.
. Select the approval status of the time entries you want to transfer.

Note: It is recommended that you only select Approved time entries for transfer
if these are being used for invoice generation.

. Click the Job/Item Time Entries tab and select the required Web TimeSheet

data filter criteria.

. Click the Apply Filters button.

The available Web TimeSheet projects/tasks are displayed in the From Web
TimeSheet Projects/Tasks box.

Note: You must click the Apply Filter button any time you make changes to the
selection criteria since a previous transfer. This ensures that the latest data is
transferred.

10.Select each project/task that you want to transfer from the From Web

TimeSheet Projects/Tasks box and click the >> button.
The selected project/task is moved to the To QuickBooks Time box.

If you want to remove a job/item from the To QuickBooks Time box, select the
job/item and click the << button.

11.Click the Time Off tab and select the time off entries that you want to transfer

from the From Web TimeSheet Time Off box and click the >> button.

The selected time off entries are moved to the To QuickBooks Time box.



12.1f you want to map fields between Web TimeSheet and QuickBooks, click the
Field Mapping tab at the top of the screen

13.When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

14.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.

15.When you are done, click the OK button.

Mapping Time Entries Data

To map time entries prior to data transfer:
1. Log on to the Integration Manager.

2. Click the General tab.

3. In the Select Direction of Data Transfer section, click the
Web TimeSheet > QuickBooks option.

4. Inthe Select Data to Transfer section, select the Time Entries check box.

5. Under the Time Entries sub tab, select your required filter criteria and click the
Apply Filters button.

6. Click the Field Mapping tab.
The Time Entries mapping sub tab containing the following is displayed:

Field Description

Structural Relationship Displays the structural relationship you
have selected.

From Web TimeSheet Select the Web TimeSheet fields from the
drop-down list that you want to map to
QuickBooks fields.

To QuickBooks Select the QuickBooks fields from the

drop-down list that you want the selected
Web TimeSheet fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.
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7. Select the fields you want to map from From Web TimeSheet and To
QuickBooks drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships

box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

8. If you want to preview the field mappings, click the Preview Data button at the

bottom of the screen.

9. When you are done mapping fields, click the General tab to return to

transferring data.

Time Entries Field Map between Web TimeSheet and QuickBooks

From Web TimeSheet To QuickBooks

Comments

Timesheet Row and Cell Level Payroll Items
UDFs

Defaults to Payroll Items.
There are no other options.

Time Off Code Payroll Items This option can be a Web
TimeSheet Time Off Code or a
UDF at the timesheet row or cell
level if available.
It is recommended that you only
map Time Off Codes to Payroll
Items if that is all you are tracking.
See the section on mapping Time
Off Codes in Chapter 1 for more
details.
Project Name Job Name Defaults to Job Name.
ltem Name/Number If class tracking is turned on in the
Class accounting preferences of
QuickBooks, then this can map to
a class in QuickBooks.
Project Code Job Name Defaults to Job Name.
ltem Name/Number If class tracking is turned on in the
Class accounting preferences of
QuickBooks, then this can map to
a class in QuickBooks.
Task Name Item Name/Number Defaults to Item Name/Number
Sub Job Name If class tracking is turned on in the
Class

accounting preferences of
QuickBooks, then this can map to
a class in QuickBooks.




From Web TimeSheet

To QuickBooks

Comments

Task Code Item Name/Number Defaults to Item Name/Number
Sub Job Name If class tracking is turned on in the
Class accounting preferences of
QuickBooks, then this can map to
a class in QuickBooks.
Role Name Item Name/Number Defaults to Item Name/Number

Class

If class tracking is turned on in the
accounting preferences of
QuickBooks, then this can map to
a class in QuickBooks.

This is available for the following
Structural Relationships:

® Project/Task>Job/Sub
Job

® Project/Role>Job/Item

Transferring Data
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Transferring Expense Entries

You can transfer details of expense entries from Web TimeSheet to QuickBooks.
The expense entries can be filtered on the basis of date range, approval status,
and client.

When choosing to transfer expenses, the following important operational issues
should be considered:

You must simultaneously select all the projects in Web TimeSheet that contain
the expenses you want to transfer. You cannot simply transfer additional
expenses later (see the third bullet below).

Because expenses are typically transferred to QuickBooks in order to add them
to a vendor bill, you should only select Approved expenses for transfer.

If you want to modify expenses after you have transferred them, the method
used by the Integration Manager effectively deletes the previously transferred
expenses and replaces them with the new expenses. When modifying
transferred expenses in this way, you must choose the new expenses in Web
TimeSheet you want to transfer, then click the Apply Filter button to make sure
that the latest data is selected.

Example

An expense sheet exists in Web TimeSheet for two projects, Project 1 and
Project 2, and you choose to transfer only expenses for Project 1. At some later
time, you want to add the expenses for Project 2. You must complete the
expense transfer process again, this time adding the expenses for Project 1 and
Project 2. The Integration Manager will effectively delete and replace the
expenses.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in QuickBooks, as described in the section Mapping Expense Entries Data.
If you choose not to map any other fields, then only the Web TimeSheet Expense
Type fields will be mapped to QuickBooks Account/Item fields.




To transfer expense entries from Web TimeSheet to QuickBooks:
1. Log in to the Integration Manager.
The Integration Manager screen appears.
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— Time Frame Approval Statug
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2. Click the General tab.

3. Inthe Select Direction of Data Transfer section, select the
Web TimeSheet > QuickBooks option.

4. Inthe Select Data to Transfer section, select the Expense Entries check box.

The Expense Entries sub tab is enabled showing the following fields.

Field Description

Submit Date Select the dates covering the period for
which you want to transfer expense

entries.

Transferring Data



54

Chapter 3

Field Description

Approval Status Select the approval status of the expense
entries you want to transfer.

Client Select the clients for whom you want data
transferred. The default is All.

From Web TimeSheet Select the Web TimeSheet items that you
want to transfer to QuickBooks.

To QuickBooks Displays the items that will be transferred.

5. Select the time frame that covers the expense entries you want to transfer.
6. Select the approval status of the expense entries you want to transfer.

Note: It is recommended that you only select Approved expenses for transfer
if the expenses are being used for invoice generation.

7. Select the required filter criteria.
8. Click the Apply Filters button.

The available Web TimeSheet projects are displayed in the From Web
TimeSheet Projects box.

Note: You must click the Apply Filter button any time you make changes to the
selection criteria since a previous transfer. This ensures that the latest data is
transferred.

9. Select each project you want to transfer from the From Web TimeSheet
Projects box, and click the >> button.

The selected project is moved to the To QuickBooks Vendor Bills box.

If you want to remove an item from the To QuickBooks Vendor Bills box, select
the item and click the << button.

10.If you want to map fields between Web TimeSheet and QuickBooks, click the
Field Mapping tab at the top of the screen

11.When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

12.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
13.When you are done, click the OK button.



Mapping Expense Entries Data

To map expense entries prior to data transfer:
1. Log on to the Integration Manager.

2. Click the General tab.

3. In the Select Direction of Data Transfer section, click the
Web TimeSheet > QuickBooks option.

4. Inthe Select Data to Transfer section, select the Expense Entries check box.

5. Under the Expense Entries sub tab, select your required filter criteria and click
the Apply Filters button.

6. Click the Field Mapping tab.

The Expense Entries mapping sub tab containing the following fields is
displayed:

Field Description

Vendor Bill Date Select the date for the expense entries
you want to transfer.

Vendor Identifiers Enter a vendor name formula in the fields
provided. (See the section Using the
Login Name Formula for more
information).

A/P Account Select an Accounts Payable account from
the drop down list.

From Web TimeSheet Select the Web TimeSheet fields from the
drop-down list that you want to map to
QuickBooks fields.

To QuickBooks Select the QuickBooks fields from the

drop-down list that you want the selected
Web TimeSheet fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

7. Select the Vendor Bill Date.

8. Enter the vendor identifiers using the appropriate name formula in the Vendor
Identifiers fields. See the section Using the Login Name Formula for more
information.
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9. Select the fields you want to map from From Web TimeSheet and To
QuickBooks drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

10.1f you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

11.When you are done mapping fields, click the General tab to return to
transferring data.

Expense Entries Field Map between Web TimeSheet and QuickBooks

From Web TimeSheet To QuickBooks Comments
Expense Sheet Description Vendor Bill Memo
Client Customer Every expense in Web

TimeSheet can be mapped to a
customer in QuickBooks, or to
None.

If there is no match, or if there is
more than one match, a message
will be displayed. You can choose
to continue the transfer without
the expenses for that client being
transferred.

Client/Project Customer: Job Every expense in Web
TimeSheet can be mapped to a
customer in QuickBooks, or to
None.

If there is no match, or if there is
more than one match, a message
will be displayed. You can choose
to continue the transfer without
the expenses for that client being
transferred.

Project Class This option is only available if
QuickBooks has been set up with
class tracking turned on in the
accounting preferences.
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From Web TimeSheet

To QuickBooks

Comments

Expense Entry Description

Memo
Class

Defaults to Memo.

This option is only available if
QuickBooks has been set up with
class tracking turned on in the
accounting preferences.

Expense Type

Expense Account

Every expense in Web
TimeSheet can be mapped to an
expense account in QuickBooks.
If there is no match, or if there is
more than one match, a message
will be displayed. You can choose
to continue the transfer with some
expenses not being transferred.

Expense Tax Code

Tax

This option requires that you add
a separate line for each tax
code/amount associated with an

expense entry in Web TimeSheet.

Expense Row Level UDF 1-5

Expense Account

Transferring Data
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You can transfer the following data from Web TimeSheet to QuickBooks:

* Employee data
* Vendor data
* Customer data
¢ Job/ltem data

Transferring Employee Data

You can transfer employee data from QuickBooks Web TimeSheet. The employee
data to be transferred can be filtered on the basis of date range, login status, and
employee type.

Before transferring data, you can map Web TimeSheet data fields to appropriate

fields in Web TimeSheet, as described in the section Mapping Employee Data. If

the fields are not mapped before transferring the data, only the First Name and Last
Name fields are transferred.

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, Web TimeSheet will create an additional item
for employee, vendor, client or project using the new name.



To transfer employee data from QuickBooks Web TimeSheet:

1. Log in to the Integration Manager.
The Integration Manager screen appears.

& web TimeSheet Integration Manager for QuickBooks llll
General I Field Mappingl Canligulatianl
7~ Select Direction of Data Transfer Load |
- - Settings
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Save |
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ilters |
™ Jobs/ltems = Time Enfries ™| Esperse Enlries
Reset |
Employees I \I'Endursl Cuslumersl Jubsflternsl Time Enlriasl Expenze Entiies
Exit |
7 QuickBooks D ata Filters
o all Help |
" Date Range Fome  [10B2005 > Tor [1ovos2o0s =]
Status: IActive > Employee Type: |<AI\> -
Apply Filters |
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<< |
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2. Click the General tab.

3. Inthe Select Direction of Data Transfer section, select the

QuickBooks > Web TimeSheet option.

In the Select Data to Transfer section, select the Employees check box.

The Employees sub tab is enabled displaying the following fields.

Field Description

Date Filter All

Date Range: From: To:

The dates can also be entered in the
mm/dd/yyyy format.

The default is the current system date.

Transferring Data



60

Chapter 3

Field Description

Status Select the status from the drop-down list.

Employee Type Select the type of employee from the
drop-down list.

From QuickBooks Select the QuickBooks employees that
you want to transfer to Web TimeSheet.

To Web TimeSheet Displays the items that will be transferred.

Select the required filter criteria.
Click the Apply Filters button.

The available QuickBooks employees are displayed in the From QuickBooks
Employees box.

Select each user you want to transfer from the From QuickBooks Employees
box and click the >> button.

The selected user is moved to the To Web TimeSheet Users box.

If you want to remove a user from the To Web TimeSheet Users box, select
the user and click the << button.

If you want to map fields between QuickBooks and Web TimeSheet, click the
Field Mapping tab at the top of the screen

When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

10.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
11.When you are done, click the OK button.

Mapping Employee Data

To map employee data prior to data transfer:

1
2
3

Log on to the Integration Manager.
Click the General tab.

In the Select Direction of Data Transfer section, click the
QuickBooks > Web TimeSheet option.

In the Select Data to Transfer section, select the Employees check box.



5. Under the Employees sub tab, select your required filter criteria and click the

Apply Filters button.
6. Click the Field Mapping tab.

The Employees sub tab containing the following fields is displayed:

Field

Description

Login Formula Name

Enter a login name formula. The Login
Name Formula is used to create new
users while transferring employee and
vendor data. (See the section Using the
Login Formula Name for more
information.)

Password

Enter the users’'s Web TimeSheet
password.

From QuickBooks

Select the QuickBooks fields from the
drop-down list that you want to map to
Web TimeSheet fields.

To Web TimeSheet

Select the Web TimeSheet fields from the
drop-down list that you want the selected
Web QuickBooks fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

7. In the Web TimeSheet User Login Information section, enter the Login
Name Formula and the Password for the user.

8. Select the fields you want to map from From QuickBooks and To Web
TimeSheet drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships

box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

9. If you want to preview the field mappings, click the Preview Data button at the

bottom of the screen.

10.When you are done mapping fields, click the General tab to return to

transferring data.
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Employee Field Map between QuickBooks and Web TimeSheet

From QuickBooks

To Web TimeSheet

Comments

Login Name Formula

Text entry. Required field.
Defaults to the setting from the
System Preferences screen.
Although there is no
corresponding QuickBooks field,
the Login Name Formula is a
required field that ensures each
new user has a valid login name
in Web TimeSheet.

The formula only applies to new
Web TimeSheet users.

Password

Text entry. Required field.
Defaults to blank.

Although there is no
corresponding QuickBooks field,
the Password field is a required
field that ensures each new user
has a valid password in Web
TimeSheet

The password only applies to new
Web TimeSheet users.

SSNor SIN

User UDF 1-5

Defaults to first UDF in the list

Date of Birth

User UDF 1-5

Defaults to first UDF in the list

Email

Internal email address
External email address

Defaults to Internal email address
Note: The External Email address
is only available as an option if
there is a license for the Web
TimeSheet Offline Timesheet
module.

Account No (Emp ID) Employee ID Defaults to Employee ID
User UDF 1-5

Custom Field Employee Type Defaults to first UDF in the list
User UDF 1-5

Hourly Rate Hourly Cost Defaults to Hourly Cost
User UDF 1-5

Hire Date Start Date

Release date End Date

Status (Active/lnactive)

Login Status
(Enabled/Disabled)




Transferring Vendor Data

You can transfer vendor data from QuickBooks to Web TimeSheet. The vendor
data to be transferred can be filtered on the basis of login status and vendor type.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in Web TimeSheet, as described in the section Mapping Vendor Data. If the

fields are not mapped before transferring the data, only the First Name and Last

Name fields are transferred.

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, Web TimeSheet will create an additional item

for employee, vendor, client or project using the new name.
To transfer employee data from QuickBooks to Web TimeSheet:
1. Log in to the Integration Manager.

The Integration Manager screen appears.
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General | Field Mappingl Configuration |
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- ﬁ\v‘ﬁmesheet = e I=>'_“\w"ﬁmeSht:.vet
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Save
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Exit
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&
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Help
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2. Click the General tab.
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3. In the Select Direction of Data Transfer section, select the
QuickBooks > Web TimeSheet.

4. In the Select Data to Transfer section, select the Vendors check box.
The Vendors sub tab is enabled displaying the following fields.

Field Description

Status Select the status from the drop-down list.

Vendor Type Select the vendor type from the drop-
down list.

From QuickBooks Select the QuickBooks employees that

you want to transfer to Web TimeSheet.

To Web TimeSheet Displays the items that will be transferred.

5. Select the required filter criteria.
6. Click the Apply Filters button.

The available Web TimeSheet users are displayed in the From QuickBooks
Vendors box.

7. Select each user you want to transfer from the From QuickBooks Vendors
box, and click the >> button.

The selected user is moved to the To Web TimeSheet Users box.

To remove a user from the To Web TimeSheet Users box, select the user and
click the << button.

8. If you want to map fields between QuickBooks and Web TimeSheet, click the
Field Mapping tab at the top of the screen

Note: Vendor names in QuickBooks may not be of the form First Name, Last Name.
When you preview the names being transferred, the Web TimeSheet mapping will
show the First Name, Last Name format, but the QuickBooks vendor names may
not have this format, however, the names will be transferred to Web TimeSheet
conforming to the First Name, Last Name format.

9. When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

10.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
11.When you are done, click the OK button.



Mapping Vendor Data

To map vendor data prior to data transfer:
1. Log on to the Integration Manager.

2. Click the General tab.

3. In the Select Direction of Data Transfer section, click the

QuickBooks >Web TimeSheet option.

4. In the Select Data to Transfer section, select the Employees check box.

5. Under the Employees sub tab, select your required filter criteria and click the

Apply Filters button.
6. Click the Field Mapping tab.

The Vendors mapping sub tab containing the following fields is displayed:

Field

Description

Login Formula Name

Enter a login name formula. The Login
Name Formula is used to create new
users while transferring employee and
vendor data. (See the section Using the
Login Formula Name for more
information.)

Password

Enter the users's Web TimeSheet
password.

From QuickBooks

You can select the QuickBooks fields from
the drop-down list that you want to map to
Web TimeSheet fields.

To Web TimeSheet

You can select the Web TimeSheet fields
from the drop-down list that you want the
selected QuickBooks fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

7. In the Web TimeSheet User Login Information section, enter the Login
Name Formula and the Password for the user.
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8. Select the fields you want to map from From QuickBooks and To Web
TimeSheet drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

9. If you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

10.When you are done mapping fields, click the General tab to return to
transferring data.



Vendor Field Map between QuickBooks and Web TimeSheet

From QuickBooks

To Web TimeSheet

Comments

Login Name Formula

Text entry. Required field.

Defaults to the setting from the
System Preferences screen.

Although there is no
corresponding QuickBooks field,
the Login Name Formula is a
required field that ensures each
new user has a valid login name
in Web TimeSheet.

The formula only applies to new
Web TimeSheet users.

Password

Text entry. Required field.
Defaults to blank.

Although there is no
corresponding QuickBooks field,
the Password field is a required
field that ensures each new user
has a valid password in Web
TimeSheet

The password only applies to new
Web TimeSheet users.

Email Internal email address Defaults to Internal email address
External email address Note: The External Email address
is only available as an option if
there is a license for the Web
TimeSheet Offline Timesheet
module.
Custom Field User UDF 1-5 Defaults to the first UDF in the list
Type Employee Type Defaults to Employee Type
User UDF 1-5
Status (Active/lnactive) Login Status Defaults to Login Status
(Enabled/Disabled)
Company User UDF 1-5 Defaults to the first UDF in the list
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Transferring Customer Data

You can transfer client/customer data from QuickBooks to Web TimeSheet. The
client/customer data can be filtered on the basis of status.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in Web TimeSheet, as described in the section Mapping Customer Data. If
the fields are not mapped before transferring the data, only the QuickBooks
Customer Name is mapped to Web TimeSheet Client Name.

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, Web TimeSheet will create an additional item
for employee, vendor, client or project using the new name.

1. Log in to the Integration Manager.

The Integration Manager screen appears.
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2. Click the General tab.



3. In the Select Direction of Data Transfer section, click the
QuickBooks > Web TimeSheet option.

4. In the Select Data to Transfer section, select the Customers check box.

The Customers sub tab is enabled and displayed displaying the following
fields.

Field Description

Active Select from the drop sown list whether you
want to select active or inactive
customers.

From QuickBooks Select the QuickBooks employees that

you want to transfer to Web TimeSheet.

To Web TimeSheet Displays the items that will be transferred.

5. Select the required filter criteria.
6. Click the Apply Filters button.

The available QuickBooks customers are displayed in the From QuickBooks
Customers box.

7. Select each client you want to transfer from the From QuickBooks Customers
box and click the >> button.

The selected customer is moved to the To Web TimeSheet Clients box.

To remove a customer from the To Web TimeSheet Clients box, select the
user and click the << button.

8. If you want to map fields between QuickBooks and Web TimeSheet, click the
Field Mapping tab at the top of the screen.

9. When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

10.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed with a progress bar indicating
the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
11.When you are done, click the OK button.
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Mapping Customer Data

To map customer data prior to data transfer:

1.
2.
3.

Log on to the Integration Manager.
Click the General tab.

In the Select Direction of Data Transfer section, click the
QuickBooks > Web TimeSheet option.

In the Select Data to Transfer section, select the Customers check box.

5. Under the Customers sub tab, select your required filter criteria and click the

Apply Filters button.
Click the Field Mapping tab.
The Customer mapping sub tab containing the following fields is displayed:

Field Description

From QuickBooks Select the QuickBooks fields from the
drop-down list that you want to map to
Web TimeSheet fields.

To Web TimeSheet Select the Web TimeSheet fields from the

drop-down list that you want the selected
QuickBooks fields mapped to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

Select the fields you want to map from From QuickBooks and To Web
TimeSheet drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

If you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

When you are done mapping fields, click the General tab to return to
transferring data.



Customer Field Map between QuickBooks and Web TimeSheet

From QuickBooks

To Web TimeSheet

Comments

Customer Name

Client UDF 1-12

Defaults to first UDF in the list

Contact

Client UDF 1-12

Defaults to first UDF in the list

Phone

Client UDF 1-12

Defaults to first UDF in the list

Fax

Client UDF 1-12

Defaults to first UDF in the list

Alt. Phone

Client UDF 1-12

Defaults to first UDF in the list

Alt. Contact

Client UDF 1-12

Defaults to first UDF in the list

Email

Client UDF 1-12

Defaults to first UDF in the list

Type

Client UDF 1-12

Defaults to first UDF in the list

Account No.

Client UDF 1-12

Defaults to first UDF in the list

Bill Address

Client UDF 1-12

Defaults to first UDF in the list

Bill City

Client UDF 1-12

Defaults to first UDF in the list

Bill State/Province

Client UDF 1-12

Defaults to first UDF in the list

Bill Zip/Postal Code

Client UDF 1-12

Defaults to first UDF in the list

Bill Country

Client UDF 1-12

Defaults to first UDF in the list

Bill Note

Comments
Client UDF 1-12

Defaults to Comments

Ship Address

Client UDF 1-12

Defaults to first UDF in the list

Ship City

Client UDF 1-12

Defaults to first UDF in the list

Ship State/Province

Client UDF 1-12

Defaults to first UDF in the list

Ship Zip/Postal Code

Client UDF 1-12

Defaults to first UDF in the list

Ship Country/Region

Client UDF 1-12

Defaults to first UDF in the list

Ship Note

Comments
Client UDF 1-12

Defaults to Comments

Rep

Client UDF 1-12

Defaults to first UDF in the list

Notes

Comments
Client UDF 1-12

Defaults to Comments

Custom Field

Client UDF 1-12

Defaults to first UDF in the list

Status (Active/lnactive)

Client Status

(Enabled/Disabled)
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Transferring Job/Item Data
You can transfer the details of jobs/items from QuickBooks to Web TimeSheet.
Before you transfer job/item data, you must define the structural relationship

between the QuickBooks data and the Web TimeSheet data. The structural
relationships you can choose from are as follows:

* QuickBooks Job/Sub Job details can be transferred to Web TimeSheet
Project/Task

* QuickBooks Item/Sub Item details can be transferred to Web TimeSheet
Project/Task

The Job/ltem data can be filtered on the basis of status and customers.

Before transferring data, you can map Web TimeSheet data fields to appropriate
fields in Web TimeSheet, as described in the section Mapping Job/ltem Data. If you
choose not to map any other fields, then only the following will be mapped by
default:

From QuickBooks To Web TimeSheet
Job Name Project Name
Sub Job Name Task Name

Note: When you make changes to employee, vendor, client or project names, you
must make identical changes in Web TimeSheet and QuickBooks prior to
transferring any data. If you do not, Web TimeSheet will create an additional item
for employee, vendor, client or project using the new name.



To transfer Job/Item data from QuickBooks to Web TimeSheet:

1. Log in to the Integration Manager.

The Integration Manager screen appears.
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. Click the General tab.

. In the Select Direction of Data Transfer section, click the
QuickBooks > Web TimeSheet option.

. In the Select Data to Transfer section, select the Jobs/ltems checkbox.

The Jobs/Items sub tab is enabled displaying the following fields.

Field Description
Structural Relationship Select the required structural relationship
from the drop down menu.
Status Select the status from the drop-down list.
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Field Description

Customer Select the customer from the drop-down
list.
From QuickBooks Select the QuickBooks customers that

you want to transfer to Web TimeSheet.

To Web TimeSheet Displays the items that will be transferred.

5. If you want to modify the structural relationship, select the required structural
relationship from the drop-down list.

6. Select the appropriate filter criteria.
7. Click the Apply Filters button.

8. The available QuickBooks jobs/items are displayed in a tree format in the From
QuickBooks Jobs/Sub Jobs box.

9. Click the + sign against the job/item name to view the item/sub item of the
joblitem.

10.Select the checkbox against the job/item/sub item name and click the >> button.

The selected job/item/sub item is displayed in the To Web TimeSheet
Projects/Tasks box.

To remove a project/task from the To Web TimeSheet Projects/Tasks box,
select the project/task and click the << button.

11.If you want to map fields between QuickBooks and Web TimeSheet, click the
Field Mapping tab at the top of the screen

12.When you have prepared the data for transfer, including any required field
mapping, you can preview the data to be transferred by clicking the Preview
Data button at the bottom of the screen.

13.Click the Transfer Data button.

The Data Transfer Status dialog box is displayed, with a progress bar
indicating the progress of transfer and a summary of the transfer session.

Note: Data which was not transferred is highlighted in red.
14.When you are done, click the OK button.



Mapping Job/Item Data

To map job/item data prior to data transfer:

1.
2.
3.

Log on to the Integration Manager.
Click the General tab.

In the Select Direction of Data Transfer section, click the
QuickBooks > Web TimeSheet option.

In the Select Data to Transfer section, select the Jobs/ltems check box.

5. Under the Job/Items sub tab, select your required filter criteria and click the

7.

Apply Filters button.
Click the Field Mapping tab.
The Job/Item mapping sub tab containing the following is displayed:

Field Description

Structural Relationship Displays the structural relationship you
have selected.

From QuickBooks You can select the QuickBooks fields from
the drop-down list that you want to map to
QuickBooks fields.

To Web TimeSheet You can select the QuickBooks fields from

the drop-down list that you want the
selected Web TimeSheet fields mapped
to.

Fields from this list can only be mapped
once.

When a field is mapped, it will no longer
be displayed in the drop-down list.

Select the fields you want to map from From QuickBooks and To Web
TimeSheet drop-down lists, and click the Add button.

The mapping relationship is displayed in the Selected Mapping Relationships
box.

To remove a mapping relationship, select the mapping relationship from the
Selected Mapping Relationships box and click the Remove button.

If you want to preview the field mappings, click the Preview Data button at the
bottom of the screen.

When you are done mapping fields, click the General tab to return to
transferring data.
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Job/Iltem Field Map between QuickBooks and Web TimeSheet

From QuickBooks

To Web TimeSheet

Comments

Job Name/Sub Job Name

Project Name/Task Name

This is available for the Structural
Relationship
Project/Task>Job/Sub Job

Job Description

Project Description

Job Status

Project/Task UDF 1-10

Defaults to first UDF in the list

Start Date

Time Entry Start Date
Expense Incur Start Date

Defaults to Time Entry Start Date

Projected End

Time Entry End Date
Expense Incur End Date
Project/Task UDF 1-10

Defaults to first UDF in the list

End Date

Time Entry End Date
Expense Incur End Date

Defaults to Time Entry End Date

Status (Active/Inactive)

Project Status
(Open/Closed)

Item Name/Sub Iltem Name

Project Name/Task Name

This is available for the Structural
Relationship
Project/Task>Item/Sub Item

Item Name/Number

Task Code

Description Task Description
ltem rate Task Estimated Cost Defaults to Estimated Cost, which
Project/Task UDF 1-10 is available only if it has not been
used for another mapping
relationship.
Custom Field Project/Task UDF 1-01 Defaults to first UDF in the list




Using the Login Name Formula

The Login Name Formula is used to create new users while transferring employee
and vendor data. These tags define how the names of users and vendors are
created when transferring data.

The available tag formulas are listed below:

First Names

$FInitial - Indicates that the initial of the first name as displayed in
QuickBooks, is used to create the login name.

$FInitialUpper - Indicates that the initial of the first name in upper case, is
used to create the login name.

$FInitialLower - Indicates that the initial of the first name in lower case, is
used to create the login name.

$FName - Indicates that the first name as displayed in QuickBooks, is used to
create the login name.

$FNameUpper - Indicates that the first name in upper case, is used to create
the login name.

$FNameLower - Indicates that the first name in lower case, is used to create the
login name.

Last Names

$LInitial - Indicates that the initial of the first name as displayed in
QuickBooks, is used to create the login name.

$LInitialUpper - Indicates that the initial of the first name in upper case, is
used to create the login name.

$LInitialLower - Indicates that the initial of the first name in lower case, is
used to create the login name.

$LName - Indicates that the first name as displayed in QuickBooks, is used to
create the login name.

$LNameUpper - Indicates that the first name in upper case, is used to create
the login name.

$LNameLower - Indicates that the first name in lower case, is used to create the
login name.
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You can create a name using a combination of the First Name and Last Name tags.

When defining a name using a combination of tags, the names must conform to the
following:

* When creating name formulas for Web TimeSheet user names, the tags
must not be separated with other characters or spaces.

For example: $FInitialLower$LNameLower

* When creating name formulas for vendors being transferred to QuickBooks,
the tags must be separated by spaces.

For example: $FName $LName



